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INTRODUCTION 
This guide is for individuals configuring a database for WinSPC, 
installing and configuring WinSPC on client stations, and 
implementing the WinSPC application server. It consists of procedures 
to accomplish these tasks for the following database servers: 

 Microsoft SQL Server 2005 
 Microsoft SQL Server 2005 Express 
 Microsoft SQL Server 2008 
 Microsoft SQL Server 2008 Express 
 Microsoft SQL Server 2012 
 Microsoft SQL Server 2012 Express 
 Oracle 10g 
 Oracle 11g 

The six Microsoft SQL Server editions are all dealt with in Chapter 1: 
Microsoft SQL Server 2005/2008/2012. A free download of these 
editions is available from Microsoft’s website. 

WinSPC is certified to run in a traditional client/server environment 
and a Microsoft Terminal Services environment. The content in this 
guide applies to both except where marked by a Terminal Services 
marker, in which case the content applies uniquely to a Microsoft 
Terminal Services environment. The first appearance of the Terminal 
Services marker is to the right of the following paragraph. 

When an implementation involves a Microsoft Terminal Services 
environment, WinSPC must be installed on the Microsoft Terminal 
Services server. If the implementation does not also involve a 
client/server environment, make the Microsoft Terminal Services 
server your first client. (First client simply refers to the first computer 
on which WinSPC is installed.) If the implementation also involves a 
client/server environment, it does not matter whether you make the 
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Microsoft Terminal Services server the first client or an additional 
client. (Additional client means any computer on which WinSPC is 
installed other than the first client.) Electing to make the Microsoft 
Terminal Services server the first client means that the procedure for 
installing WinSPC on the Microsoft Terminal Services server is the 
procedure detailed in Phase 2 of the chapter specific to the database 
server being used in your implementation. Electing to make the 
Microsoft Terminal Services server an additional client means that the 
procedure for installing WinSPC on the Microsoft Terminal Services 
server is the procedure detailed in Chapter 5: Additional Client 
Installs and Configurations. 

For WinSPC’s hardware requirements and recommended platforms, 
see Appendix F: Hardware Requirements and Recommended 
Platforms. 

DataNet Quality Systems wants your installation and configuration to 
be a positive experience. Please do not hesitate to contact our Product 
Support Help Desk at (248)-447-0140 if you have questions 
concerning any of the information in this guide. 
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CHAPTER 1: MICROSOFT SQL SERVER 2005/2008/2012 
WinSPC is certified to run on the following editions of Microsoft SQL 
Server: Microsoft SQL Server 2005 Express, Microsoft SQL Server 2005, 
Microsoft SQL Server 2008 Express, Microsoft SQL Server 2008, Microsoft 
SQL Server 2012 Express and Microsoft SQL Server 2012. This chapter 
applies to each of these editions. 

The procedure to configure any of these six editions for use with WinSPC is 
nearly identical to that of the other five. Consequently, where images of 
Microsoft SQL Server prompts are used for illustration, they are exclusively 
from Microsoft SQL Server 2005 Express. In addition, where the text of this 
chapter applies to all editions equally, edition-specific information is omitted 
in favor of generic titles such as Microsoft SQL Server or SQL Server 
Management Studio. 

ASSUMPTIONS 
The instructions in this chapter are based on the following 
assumptions: 

 Microsoft SQL Server is installed on your database server 
machine. 

 An instance of Microsoft SQL Server has been created for 
WinSPC and is running. (This instance may be named or 
unnamed.) 

 During the creation of this instance, the authentication mode 
selected was Mixed Mode (Windows Authentication and SQL 
Server Authentication). (WinSPC will not function if the default 
Windows Authentication Mode was accepted.) 
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 The management and configuration tools appropriate to your 
edition of Microsoft SQL Server are installed on your database 
server machine. At a minimum, these include SQL Server 
Management Studio and SQL Server Configuration Manager. 

 Other than the Mixed Mode of authentication and where an 
exception is clearly noted, the default values presented by your 
Microsoft SQL Server edition during the setup process were 
accepted without modification. 

 The no count option in Microsoft SQL Server is disabled. This 
option, if enabled, will interfere with WinSPC functionality. It is 
disabled by default when Microsoft SQL Server is installed. (To 
locate this option: i. In the Object Explorer of Microsoft SQL 
Server Management Studio, right-click the SQL Server instance 
to be used by WinSPC and select Properties; ii. In the Server 
Properties prompt that appears, under Select a Page, click 
Connections; iii. under Default connection options, scroll down 
until no count is visible.) 

 Firewalls between your database server and the client stations to be 
used for WinSPC are configured to permit database traffic. 

 For implementations employing a Microsoft Terminal Services 
environment, Microsoft Terminal Services is properly installed and 
configured on the server designated as your Microsoft Terminal 
Services server and the client stations that will run WinSPC on this 
server can successfully establish a Remote Desktop Protocol 
(RDP) connection to the server. 

 For editions of Microsoft SQL Server other than SQL Server 2012, 
the operating system of your database server machine is Windows 
Server 2003 or Windows Server 2008. For SQL Server 2012, the 
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operating system of your database server machine is Windows 
Server 2008. 

 The operating system of the client machines to be used for 
WinSPC is Windows 7, Windows Vista Business or Windows XP 
Pro. (Images of client machines included in this guide are from 
Vista Business.) 

NOTE: If a default value was modified during the setup Microsoft 
SQL Server or an operating system is different from that 
stated here, adapt the instructions in this guide as needed to 
accommodate the modified value or differing operating 
system. 
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SERVER CONFIGURATION 

Establish a Server Connection 
1. On the database server machine, launch SQL Server 

Management Studio, the default path for which is Start > All 
Programs > Microsoft SQL Server> SQL Server Management 
Studio. 

2. In the Connect to Server prompt that appears: 

a. At Server Type, accept the Database Engine default. 

b. At Server name, if a name is not displayed or the name 
displayed is not the name of the machine on which the instance 
of Microsoft SQL Server to be used for WinSPC is created, 
select the correct name from the dropdown list. Depending on 
your edition of Microsoft SQL Server and the options selected 
during this edition’s setup, the instance for your 
implementation may be named or unnamed. If your instance is 
named, the correct name for this Server name field consists of 
a combination of the server name and the instance name (e.g. 
TESTSERVER\SQLEXPRESS). If your instance is unnamed, 
the correct name for this Server name field consists of the 
server name alone (e.g. TESTSERVER). In the event the server 
name displayed is incorrect and the dropdown list does not 
contain the correct name: 

i. From the Server name dropdown list, select <Browse for 
more…>. 

ii. In the Browse for Servers prompt, click the Network 
Servers tab. This automatically initiates a search for 
servers on your network. 

Phase 1 of 4 
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iii. When the search completes, expand Database Engine and 
single-click the desired server name or server 
name\instance name combination. 

iv. Click OK. 

c. At Authentication, select SQL Server Authentication. 

d. At Login, enter sa. 

e. At Password, enter the password assigned to the sa login. 

f. Click Connect. 
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NOTE: If the Connect to Server prompt is not displayed, click 
File > New > Database Engine Query in Microsoft 
SQL Server Management Studio and complete the 
preceding substeps in the Connect to Database Engine 
prompt. 
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Create a Database 
DataNet Quality Systems recommends that a new database be created 
for the exclusive use of WinSPC. Use of a WinSPC database by other 
applications is not tested and consequently not certified by DataNet. 

1. In the Object Explorer (i.e. the left pane) of Microsoft SQL 
Server Management Studio, right-click Databases and, from the 
shortcut menu, select New Database. 

 



Chapter 1: Microsoft SQL Server 2005/2008/2012 

10 Installation and Configuration Guide 

2. In the New Database prompt, at Database name, create and enter 
a name for the database. (The recommended database name is 
WinSPC.) 
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3. If you are configuring a full, as opposed to express, version of 
Microsoft SQL Server, you may want to consider changing the 
default Recovery Model from Full to Simple. This helps prevent 
Microsoft SQL Server’s transaction log from growing to a point 
where it interferes with database performance. To change the 
Recovery Model to Simple, under Select a page, click Options 
and, at Recovery model select Simple. 
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NOTE:  According to Microsoft, with the Recovery Model set to 
Simple, a database can only be recovered to the time of 
the most recent backup. This means that data captured 
between the most recent backup and a failure which 
necessitates a recovery is lost. If this is an unacceptable 
risk for your organization, use the Full or Bulk-logged 
option and follow Microsoft’s recommendations to control 
the size of your transaction log. 

4. Click the New Database prompt’s OK button. 
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Create a Server Login 
1. In the Object Explorer, right-click the Security folder and select 

New > Login. 

 
(The Security folder referred to here is the one in the root level of 
the folder for the server or server\instance you are configuring, not 
a Security sub-folder within a database folder under the root 
Databases folder.) 
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2. In the Login - New prompt: 

a. At Login name, create and enter a name for the login. (The 
recommended name is JOHNDOE.) 

b. Select SQL Server authentication. 

c. At Password, create and enter a sufficiently strong password 
for the login. 

d. At Confirm password, reenter the password. 

NOTE: The user name and password entered here will be used by 
Microsoft SQL Server to authentic WinSPC client 
stations and allow authenticated stations access to the 
WinSPC database. This user name and password 
combination is not directly used by WinSPC users.  
WinSPC users will, later, be assigned individual user IDs 
and passwords and will use these individual IDs and 
passwords to log into the WinSPC application on 
WinSPC client stations. 

e. Uncheck the Enforce password policy check box. 
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f. At Default database, select WinSPC.  
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3. Under Select a page (top left pane), single-click User Mapping 
and then, in the right portion of the prompt: 

a. Under Users mapped to this login, in the Map column, check 
the check box for the newly created WinSPC database. 

b. Under Database role membership for: <Database Name>, 
check the db_owner check box. 

c. Click OK. 
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Configure the SQL Server Browser Service and Enable a Network 
Protocol 
1. Without exiting Microsoft SQL Server Management Studio, 

launch SQL Server Configuration Manager, the default path for 
which is Start > All Programs > Microsoft SQL Server > 
Configuration Tools > SQL Server Configuration Manager. 

2. If the Microsoft SQL Server instance you are working with is not a 
named instance, go to step 3. If the instance you are working with 
is a named instance, configure the SQL Server Browser service. 
(If you don’t know whether the instance is named or unnamed, 
assume it is named.) To configure the SQL Server Browser 
service: 

a. In the left pane of SQL Server Configuration Manager, click 
SQL Server Services. 
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b. In the right pane, right-click SQL Server Browser and select 
Properties. 

c. In the SQL Server Browser Properties prompt, click the 
Service tab. 

d. On this tab, to the right of Start Mode, click Disabled and 
select Automatic. 
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e. Click the Apply button. 

f. Click the Log On tab and on this tab click the Start button. 

 
g. Allow the progress bar that appears to complete. 

h. Click OK.  



Chapter 1: Microsoft SQL Server 2005/2008/2012 

20 Installation and Configuration Guide 

3. Enable a network protocol. To do this: 

a. In the left pane of SQL Server Configuration Manager, 
expand SQL Server Network Configuration and single-click 
Protocols for <SERVER OR INSTANCE NAME>. 
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b. In the right pane, right-click either TCP/IP or Named Pipes 
and click Enable. (WinSPC works with either of these options. 
If you are unsure of which option to choose, consult your 
network administrator.) 

 
c. In the warning indicating that changes will not take effect until 

the service is stopped and restarted, click OK. 

 
d. Close SQL Server Configuration Manager. 
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e. In Microsoft SQL Server Management Studio, right-click 
the server you’ve been configuring and select Stop. 

 
f. In the message box that appears, click Yes to confirm you want 

to stop the service. 
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g. When the message box closes, right-click the server again and 
select Start. 
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h. In the message box that appears, click Yes to confirm you want 
to start the service. 

 
i. Click File > Exit to close Microsoft SQL Server 

Management Studio. 

 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

   

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 
This section concerns the installation and configuration of WinSPC on 
the first WinSPC client. The first WinSPC client refers to the first 
computer on which you want to install WinSPC. This computer can be 
any computer on your network.  

If your implementation employs Microsoft Terminal Services, see the 
discussion on page 1 of this guide for direction on whether to make 
your first client the Microsoft Terminal Services server or another 
computer.   

1. Create a folder on a network file server accessible by all client 
stations that will run WinSPC. This folder’s primary purpose is to 
facilitate the installation and configuration of WinSPC on all 
clients other than the first client. (The recommended name for this 
folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators at least the 
minimum required permissions to it. For file servers running 
Windows Server 2003, the minimum Share permissions are 
Change and the minimum Security permissions are Modify.  For 
file servers running Windows Server 2008, the minimum Share 
permissions are Contributor and the minimum Security 
permissions are Modify. (For a procedure on granting Share or 
Security permissions, see Appendix C: Granting Share and 
Security Permissions.) 
NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these minimum permissions 
to the local administrator who will install and configure 
WinSPC on the first WinSPC client. 
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3. Log into Windows on the first WinSPC client as a domain 
administrator who also has local administrator privileges. 

NOTE: If the first WinSPC client is part of a workgroup instead 
of a domain, log in as a local administrator. 

4. Disable User Account Control (UAC) if the operating system on 
the first client machine has this security feature enabled. Refer to 
Appendix G for instructions on doing this. You will be given the 
option of enabling UAC in step 20 of Chapter 4: First Client 
Configuration (Final Steps). 

5. If you downloaded Install.exe from 
www.winspc.com/support/download-winspc: 

a. Transfer this file to the first WinSPC client if it was 
downloaded to a different computer. 

b. Double-click the file. 

c. If an Open File – Security Warning prompt appears, click 
Run. 

d. Go to step 7.  

http://www.winspc.com/support/download-winspc
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6. If you have the WinSPC CD (whether as a result of receiving it 
from DataNet Quality Systems or burning it from the WinSPC.iso 
file at www.winspc.com/support/download-winspc) and you did 
not complete the preceding step: 

a. Insert and run the CD. 

b. On the WinSPC Version 8.n setup prompt that appears, click 
Install or Upgrade. 

 
c. Go to step 7. 

http://www.winspc.com/support/download-winspc
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7. Complete the WinSPC Installation Wizard. 

NOTE: The prompts of this wizard are intended to be self-
explanatory. Consequently, they are not detailed here. If 
you have a question about a prompt or want to be directed 
step-by-step through the wizard, see Appendix A: The 
WinSPC Installation Wizard. 

8. If you installed WinSPC from a CD, exit the WinSPC Version 8.n 
setup prompt by clicking Close in the upper right corner and 
remove the CD from the CD-ROM drive. 

9. Click Start > All Programs > WinSPC > WinSPC.  This 
launches the WinSPC Configuration Wizard. 

10. On the Language prompt, from the Select language list, choose a 
language and click Next. 
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NOTE: The language selected here is the language in which the 
remainder of the WinSPC Configuration Wizard will run. 
It also becomes the system-wide default language for 
WinSPC. (This default language can be changed at any 
time following the completion of the WinSPC 
Configuration Wizard. Once the configuration of the first 
WinSPC client is complete, you can see the WinSPC 
Help for more information on default languages.) 
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11. On the Database Server Type prompt, select your Microsoft 
SQL Server edition and click Next. 

 
(Although Microsoft SQL Server 2012 and Microsoft SQL Server 
2012 Express are supported database servers for WinSPC, these 
are not included in the above list. Consequently, if the database 
server you want to use is Microsoft SQL Server 2012, select 
Microsoft SQL Server 2008. If it is Microsoft SQL Server 2012 
Express, select Microsoft SQL Server 2008 Express.) 
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12. On the Microsoft SQL Server Settings prompt: 

a. At Machine Name, if the instance of Microsoft SQL Server 
designated for WinSPC is a named instance, enter the name of 
the machine on which the instance is created and the name of 
the instance, separating the two by a backslash (e.g. 
Testserver\SQLExpress). If the instance is an unnamed 
instance, enter the server name only. If you do not know 
whether the instance is named or unnamed or if you know the 
instance is named but are unsure of the name used, contact the 
server administrator. 

b. At Database Name, enter the database name you chose in step 
2 of this chapter’s Create a Database section. 

c. Click Next. 
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13. On the Database Server Log In prompt, enter the server User 
Name and Password created in step 2 of this chapter’s Create a 
Server Login section and click Next. 
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14. On the Database Communications Test prompt, click Next. 

 
If you get a Database Communications Error indicating there is 
an invalid connection string attribute, the communication test 
failed. The most likely causes of the failure and their remedies are: 

 The database server login was entered incorrectly. To remedy 
this, click the Back button two times and re-enter the user 
name and password, ensuring you have the correct user name 
and password and that these are spelled correctly. Also, since 
passwords are case sensitive, ensure appropriate capitalization 
is used for the password. Once you have re-entered the login, 
click Next and advance through the WinSPC Configuration 
Wizard again, verifying the information on each prompt as you 
do. 
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 The machine name, instance name or database name was 
entered incorrectly. To remedy this, click the Back button 
three times and re-enter the machine name, instance name (if 
you are working with a named instance) and database name, 
ensuring you have the correct names and that these are spelled 
correctly. Also, when entering an instance name, ensure it is 
properly separated from the machine name by a backslash (e.g. 
Testserver\SQLExpress.) Once you have re-entered the 
name(s), click Next and advance through the WinSPC 
Configuration Wizard again, verifying the information on each 
prompt as you do. 

 The instance being used for WinSPC is a named instance but 
the SQL Server Browser service is not configured. To remedy 
this, complete steps 1 and 2 of the Configure the SQL Server 
Browser Service and Enable a Network Protocol section 
earlier in this chapter, then click the Back button in the 
WinSPC Configuration Wizard once and try the database 
communications test again. 

 A network protocol has not been enabled. To remedy this, 
repeat steps 1 and 3 of the Configure the SQL Server 
Browser Service and Enable a Network Protocol section 
earlier in this chapter, then click the Back button in the 
WinSPC Configuration Wizard once and try the database 
communications test again. 
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 A network protocol was enabled but the instance was not 
restarted afterwards. To remedy this, repeat steps 1 and 3e-3h 
of the Configure the SQL Server Browser Service and 
Enable a Network Protocol section earlier in this chapter, 
then click the Back button in the WinSPC Configuration 
Wizard once and try the database communications test again. 

15. On the Database Creation prompt, click Next.  This creates the 
WinSPC schema within the WinSPC database. 
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16. Allow the prompt’s progress bar to complete. 
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17. If you selected a language other than English in step 10 of this 
section, an Add Language prompt appears once the WinSPC 
schema is created. In this case: 

a. Insert the language disk for the selected language into your 
floppy drive and click the OK button. (Language disks are 
included in your WinSPC materials. If you didn’t order a 
language disk and, consequently, did not receive one, click the 
Cancel button and complete the WinSPC Configuration 
Wizard without adding the language. Later, you can order the 
language disk and, once the disk arrives, add the language 
using the Add Language option on the Administrator 
window’s Tools menu in WinSPC. Until the language is added, 
you’ll be restricted to running WinSPC in English. The 
remainder of the WinSPC Configuration Wizard continues to 
run in the selected language whether or not a language is added 
from a language disk.)  

b. In the message asking if you want to proceed with the addition 
of the detected language, click OK. 

c. If a message indicating the detected language has already been 
installed appears, click OK. 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 
System Settings, Station Setup, or User Setup message 
appears, click OK.   

f. If the Add Language prompt reappears, click Cancel. 
g. Remove the language disk from the floppy drive. 
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THIS COMPLETES PHASE 2 OF 4.   

GO TO CHAPTER 4: FIRST CLIENT 
CONFIGURATION (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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CHAPTER 2: ORACLE 10g 
ASSUMPTIONS 
The instructions in this chapter are based on the following 
assumptions: 

 Oracle Database 10g software is installed on your database server. 

 An Oracle Database 10g global database of the Enterprise 
Edition installation type is created and running on your database 
server and you have been authorized to use part of this global 
database for WinSPC. 

 Oracle Database 10g Client is installed on the first WinSPC client 
and that installation is of the Administrator type (as compared to 
the Runtime or Custom types). (The first WinSPC client refers to 
the first computer on which you want to install WinSPC. This 
computer can be any computer on your network. If the operating 
system of this client is Windows Vista Business, you must use the 
10.2.0.3.0 edition of Oracle Database 10g Client. If the operating 
system is Windows XP Pro, you may use either the 10.2.0.3.0 
edition or the earlier 10.2.0.1.0 edition.) 

 The necessary Oracle Database 10g Client utilities are installed an 
all other clients. (If the operating system of an additional client is 
Windows Vista Business, the necessary utilities are Oracle 
Provider for OLE DB and Oracle Net from the 10.2.0.3.0 edition 
of Oracle Database 10g Client. If the operating system is Windows 
XP Pro, the necessary utilities vary with the edition of Oracle 
Database 10g Client being used. If that edition is 10.2.0.3.0, the 
necessary utilities are the same as those for Windows Vista 
Business. If that edition is 10.2.0.1.0, the necessary utilities consist 
only of Oracle Provider for OLE DB.  Incidentally, regardless of 
the operating system or edition of Oracle Database 10g Client 
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installed on your clients, if your organization’s intended use of 
WinSPC includes taking data stored in an Oracle ODBC data 
source and collecting it into the Oracle database you are 
configuring for WinSPC, Oracle ODBC Driver from Oracle 
Database 10g Client will need to be installed on each WinSPC 
client to be used in collecting that stored data. Since the presence 
of this driver presents no complication, DataNet Quality Systems 
recommends installing it even if the use of WinSPC to collect data 
from an Oracle ODBC data source is only a possibility. The 
Administrator type of client mentioned in the preceding 
assumption includes this driver and consequently does not need to 
separately installed on the first WinSPC client.) 

 The default values presented by Oracle Database 10g and Oracle 
Database 10g Client during the installation process were accepted 
without modification. 

 Any firewalls between your database server and the client stations 
to be used for WinSPC are properly configured to permit database 
traffic. 

 For implementations employing a Microsoft Terminal Services 
environment, Microsoft Terminal Services is properly installed and 
configured on the server designated as your Microsoft Terminal 
Services server. 

NOTE: You may find that users who don’t have administrative 
permissions to the Microsoft Terminal Services server are 
unable to launch WinSPC via a Remote Desktop Protocol 
session. This is a circumstance specific to Oracle 
Database 10g and Oracle Database 11g. It can be 
remedied by changing the Permission Capability on the 
Microsoft Terminal Services server from Full Security to 
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Relaxed Security. Alternatively, consult your network 
administrator and/or Oracle DBA for other remedies.   

 The operating system of your database server machine is Windows 
Server 2003 or Windows Server 2008. 

 The operating system of the client machines to be used for 
WinSPC is Windows 7, Windows Vista Business or Windows XP 
Pro. (Images of client machines included in this guide are from 
Vista Business.) 

NOTE: If a default value was modified during the installation of 
Oracle Database 10g or an operating system is different from 
that stated here, adapt the instructions in this guide as needed 
to accommodate the modified value or differing operating 
system. 

Prior to beginning this procedure, it’s advised that you locate 
the hostname (or machine name) for the Oracle Database 10g 
machine and the Oracle Database 10g global database system 
identifier (SID), user name and password. Your database 
administrator should be able to provide this information. 
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Phase 1 of 4 

   

     

SERVER CONFIGURATION 

Create a Tablespace 
1. On the first WinSPC client station, launch the Enterprise 

Manager Console. The default path for this is: Start > All 
Programs > Oracle – OraClient10g_home1 > Enterprise 
Manager Console. (See the third assumption at the beginning of 
this chapter for a definition of the first WinSPC client.) 

NOTE: If the Enterprise Manager Console is not listed in the 
Start menu, it is probably because the Administrator 
installation type was not selected when Oracle Database 
10g Client was installed. In this case, reinstall Oracle 
Database 10g Client, selecting Administrator in the 
Select Installation Type prompt and then return to this 
step. 

2. In the Add Databases To Tree prompt: 

a. At Hostname, enter the machine name of the Oracle Database 
10g server. 

b. At Port Number, accept the default value of 1521 unless your 
DBA has instructed you to use a different port number. 

c. At SID, enter the system identifier for the Oracle global 
database to be used by WinSPC. 

d. At Net Service Name, overwrite the net service name that is 
automatically created with a name you want to use to uniquely 
identify the WinSPC net service. (The recommended net 
service name is WINSPC.)   
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e. Click OK. 

 
NOTE: If the Add Databases To Tree prompt doesn’t 

automatically appear after step 1, it can be displayed by 
selecting Add Database To Tree from the Navigator 
menu in the Oracle Enterprise Manager Console. 
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3.   In the left pane of the Oracle Enterprise Manager Console, 
expand Network > Databases and click the plus sign to the left of 
the net service name from step 2d. 
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4.   In the Database Connect Information prompt that is displayed:  

a. At Username, enter the username for the global database. 

b. At Password, enter the password associated with this user 
name. 

c. At Connect as, select SYSDBA from the dropdown list. 

d. Click OK. 
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5.   In the left pane, beneath the newly added net service name, expand 
Storage, right-click Tablespaces and, from the shortcut menu, 
select Create. 

NOTE: If you do not see Create on the shortcut menu, press the 
ESC button to exit the menu and right-click Tablespaces 
again. 
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6.   In the Create Tablespace prompt, on the General tab: 

a. At Name, create and enter a name for the tablespace to be used 
for WinSPC. (Notice that, as you enter the name, it is 
automatically populated into the Datafiles section, forming a 
file name for the tablespace.) 
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b. At Size, double-click 5. 
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7.   In the Create Datafile prompt that is displayed, click the Storage 
tab. 
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8.   On the Storage tab: 

a. Check the Automatically extend datafile when full 
(AUTOEXTEND) check box. 

b. Specify 5 M Bytes as the size by which the datafile should be 
incremented. (Your database administrator can monitor your 
database usage and tune this value as needed.) 

c. At Maximum Size, accept the default Unlimited. 
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d. Click OK. 
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9.   In the Create Tablespace prompt, click Create. 
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10.  When the Tablespace created successfully message appears, 
click OK. 

 

Create a Server Login 
1. Still beneath the newly created net service name, expand Security, 

right-click Users and, from the shortcut menu, click Create. 
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2. In the Create User prompt, on the General tab: 

a. At Name, create and enter a name for the login. (The 
recommended user name is JOHNDOE.) 
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b. At Enter Password, create and enter a sufficiently strong 
password for the login. 

c. At Confirm Password, reenter the password. 

NOTE: The name and password entered here will be used by 
Oracle Database 10g to authentic WinSPC client stations 
and allow authenticated stations access to the WinSPC 
tablespace. This name and password combination is not 
directly used by WinSPC users. WinSPC users will, later, 
be assigned individual user IDs and passwords. They will 
use these individual user IDs and passwords to log into 
the WinSPC application on WinSPC client machines. 

d. In the Tablespaces section, at Default, select the tablespace 
name created in step 6a of this chapter’s Create a Tablespace 
section.  

e. At Temporary, select TEMP.  
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f. Leave Status as Unlocked. 
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3. Without clicking Create, click the Role tab and, in the Available 
list, double-click RESOURCE. This copies RESOURCE to the 
Granted list. 
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4. Click the System tab and, in the Available list, double-click 
CREATE ANY INDEX. This copies CREATE ANY INDEX to 
the Granted list. 
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5. Click Create. 
6. When the User created successfully message appears, click OK. 

 

Set the Number of Open Cursors 
1. Calculate the required number of open cursors using this formula: 

open_cursors = number of WinSPC licenses * 50 
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2. Still in the Oracle Enterprise Manager Console, in the left pane, 
expand Instance and click Configuration.  
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3. In the right pane, click All Initialization Parameters toward the 
bottom of the General tab. 

 
4. In the Edit Database: Configuration prompt, scroll to 

open_cursors, replace the default number of open cursors in the 
Value column with the number you calculated in step 1 and click 
Apply. 
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5. When the Parameters have been changed message appears, click 
OK.  

 
6. Close the Oracle Enterprise Manager Console by clicking File > 

Exit. 

Test the Local Net Service Name 
1. Still on the first client machine, click Start > All Programs > 

Oracle – OraClient10g_home1 > Configuration and Migration 
Tools > Net Configuration Assistant. 
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2. In the Oracle Net Configuration Assistant: Welcome prompt, 
select Local Net Service Name configuration and click Next. 
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3. Select Test and click Next. 
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4. Select the net service name you specified in step 2d of this 
chapter’s Create a Tablespace section, if it isn’t already selected, 
and click Next.  
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5. In the next prompt, which indicates the test did not succeed, click 
the Change Login button. 
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6. In the Change Login prompt, replace the default username and 
password with the username and password you created in step 2 of 
this chapter’s Create a Server Login section and click OK. 
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7. When the test is indicated as having succeeded, click Next. 
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8. Click Next when the net service name configuration is indicated as 
complete. 
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9. On the Welcome prompt, click Finish. 

 

 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

   

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 
This section concerns the installation and configuration of WinSPC on 
the first WinSPC client. (See the third assumption at the beginning of 
this chapter for a definition of the first WinSPC client.) 

If your implementation employs Microsoft Terminal Services, see the 
discussion on page 1 of this guide for direction on whether to make 
your first client the Microsoft Terminal Services server or another 
computer.   

1. Create a folder on a network file server accessible by all client 
stations that will run WinSPC. This folder’s primary purpose is to 
facilitate the installation and configuration of WinSPC on all 
clients other than the first client. (The recommended name for this 
folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators at least the 
minimum required permissions to it. For file servers running 
Windows Server 2003, the minimum Share permissions are 
Change and the minimum Security permissions are Modify.  For 
file servers running Windows Server 2008, the minimum Share 
permissions are Contributor and the minimum Security 
permissions are Modify. (For a procedure on granting Share or 
Security permissions, see Appendix C: Granting Share and 
Security Permissions.) 
NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these minimum permissions 
to the local administrator who will install and configure 
WinSPC on the first WinSPC client station. 
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3. Log into Windows on the first WinSPC client station as a domain 
administrator who also has local administrator privileges. 

NOTE: If the first WinSPC client is part of a workgroup instead 
of a domain, log in as a local administrator. 

4. Disable User Account Control (UAC) if the operating system on 
the first client machine has this security feature enabled. Refer to 
Appendix G for instructions on doing this. You will be given the 
option of enabling UAC in step 20 of Chapter 4: First Client 
Configuration (Final Steps). 

5. If you downloaded Install.exe from 
www.winspc.com/support/download-winspc: 

a. Transfer this file to the first WinSPC client if it was 
downloaded to a different computer. 

b. Double-click the file. 

c. If an Open File – Security Warning prompt appears, click 
Run. 

d. Go to step 7.  

http://www.winspc.com/support/download-winspc
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6. If you have the WinSPC CD (whether as a result of receiving it 
from DataNet Quality Systems or burning it from the WinSPC.iso 
file at www.winspc.com/support/download-winspc) and you did 
not complete the preceding step: 

a. Insert and run the CD. 

b. On the WinSPC Version 8.n setup prompt that appears, click 
Install or Upgrade. 

 
c. Go to step 7. 

 

http://www.winspc.com/support/download-winspc
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7. Complete the WinSPC Installation Wizard. 

NOTE: The prompts of this wizard are intended to be self-
explanatory. Consequently, they are not detailed here. If 
you have a question about a prompt or want to be directed 
step-by-step through the wizard, see Appendix A: The 
WinSPC Installation Wizard. 

8. If you installed WinSPC from a CD, exit the WinSPC Version 8.0 
setup prompt by clicking Close in the upper right corner and 
remove the WinSPC CD from the CD-ROM drive. 

9. Click Start > All Programs > WinSPC > WinSPC.  This 
launches the WinSPC Configuration Wizard. 
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10. On the Language prompt, from the Select language list, choose a 
language and click Next.  

 
NOTE: The language selected here is the language in which the 

remainder of the WinSPC Configuration Wizard will run. 
It also becomes the system-wide default language for 
WinSPC. (This default language can be changed at any 
time following the completion of the WinSPC 
Configuration Wizard. Once the configuration of the first 
WinSPC client is complete, you can see the WinSPC 
Help for more information on default languages.) 



Chapter 2: Oracle 10g 

  Installation and Configuration Guide 79 

11. On the Database Server Type prompt, select Oracle Database 
10g and click Next. 
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12. On the Oracle Server Settings prompt: 

a. At Path of TNSNAMES.ORA, accept the default location. 

b. In the Database Alias text box, enter the Net Service Name 
you chose in step 2d of this chapter’s Create a Tablespace 
section. 

c. Click Next. 
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13. On the Database Server Log In prompt, enter the server User 
Name and Password created in step 2 of this chapter’s Create a 
Server Login section and click Next. 
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14. On the Database Communications Test prompt, click Next. 

 
In the event the test fails: 

 If the error message displayed reads ORA-12154: TNS: could 
not resolve the connect identifier specified., click the Back 
button three times and reenter the database alias, ensuring you 
have the correct name and that it is spelled correctly. Once 
you’ve reentered this information, advance through the 
WinSPC Configuration Wizard again by clicking Next, 
verifying the information on each prompt as you do. 
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 If the error message reads ORA-01017: invalid 
username/password; logon denied, click the Back button 
twice and reenter the server user name and password, ensuring 
you have the correct user name and password and that these are 
spelled correctly. Also, since passwords are case sensitive, 
ensure the appropriate capitalization is used for the password. 
Once you’ve reentered this information, advance through the 
WinSPC Configuration Wizard again by clicking Next, 
verifying the information on each prompt as you do. 

15. On the Database Creation prompt, click Next.  This creates the 
WinSPC schema within the WinSPC database. 
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16. Allow the prompt’s progress bar to complete. 
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17. If you selected a language other than English in step 10 of this 
section, an Add Language prompt appears once the WinSPC 
schema is created. In this case: 

a. Insert the language disk for the selected language into your 
floppy drive and click the OK button. (Language disks are 
included in your WinSPC materials. If you didn’t order a 
language disk and, consequently, did not receive one, click the 
Cancel button and complete the WinSPC Configuration 
Wizard without adding the language. Later, you can order the 
language disk and, once the disk arrives, add the language 
using the Add Language option on the Administrator 
window’s Tools menu in WinSPC. Until the language is added, 
you’ll be restricted to running WinSPC in English. The 
remainder of the WinSPC Configuration Wizard continues to 
run in the selected language whether or not a language is added 
from a language disk.)  

b. In the message asking if you want to proceed with the addition 
of the detected language, click OK. 

c. If a message indicating the detected language has already been 
installed appears, click OK. 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 
System Settings, Station Setup, or User Setup message 
appears, click OK. 

f. If the Add Language prompt reappears, click Cancel. 
g. Remove the language disk from the floppy drive. 
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THIS COMPLETES PHASE 2 OF 4. 

GO TO CHAPTER 4: FIRST CLIENT 
CONFIGURATION (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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CHAPTER 3: ORACLE 11g 
ASSUMPTIONS 
The instructions in this chapter are based on the following 
assumptions: 

 Oracle Database 11g software is installed on your database server 
and the installation type is Enterprise Edition. 

 Oracle Database 11g’s Starter database is created and running on 
your database server and you have been authorized to use this 
database for WinSPC. 

 The Net Configuration Assistant from Oracle Database 11g 
Client is installed on the first WinSPC client machine. (The first 
WinSPC client machine simply refers to the first computer on 
which you want to install WinSPC.  This computer can be any 
client machine on your network.) 

 A 32-bit edition of Oracle Provider for OLE DB from Oracle 
Database 11g Client is installed on all client machines which are to 
run WinSPC (including the first client). The 32-bit edition is 
required regardless of whether the client machine is 32-bit or 64-
bit. (Incidentally, if your organization’s intended use of WinSPC 
includes taking data stored in an Oracle ODBC data source and 
collecting it into the Oracle database you are configuring, Oracle 
ODBC Driver from Oracle Database 11g Client will need to be 
installed on each WinSPC client to be used in collecting that stored 
data. Since the presence of this driver presents no complication, 
DataNet Quality Systems recommends installing it even if the use 
of WinSPC to collect data from an Oracle ODBC data source is 
only a possibility.) 
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 The default values presented by Oracle Database 11g during the 
installation process were accepted without modification.   

 Any firewalls between your database server and the client 
machines to be used for WinSPC are properly configured to permit 
database traffic. 

 For implementations employing a Microsoft Terminal Services 
environment, Microsoft Terminal Services is properly installed and 
configured on the server designated as your Microsoft Terminal 
Services server. 

NOTE: You may find that users who don’t have administrative 
permissions to the Microsoft Terminal Services server are 
unable to launch WinSPC via a Remote Desktop Protocol 
session. This is a circumstance specific to Oracle 
Database 10g and Oracle Database 11g. It can be 
remedied by changing the Permission Capability on the 
Microsoft Terminal Services server from Full Security to 
Relaxed Security. Alternatively, consult your network 
administrator and/or Oracle DBA for other remedies.   

 If the edition of Oracle Database 11g to be configured for use 
with WinSPC is Release 2, the Server Class option was selected 
during the installation. This option is presented on the System 
Class installation prompt but is not selected by default.   

 The operating system of your database server machine is Windows 
Server 2003 or Windows Server 2008. 

 The operating system of the client machines to be used for 
WinSPC is Windows 7, Windows Vista Business or Windows XP 
Pro. (Images of client machines included in this guide are from 
Vista Business.) 
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NOTE: If a default value was modified during the installation of 
Oracle Database 11g or an operating system is different from 
that stated here, adapt the instructions in this guide as needed 
to accommodate the modified value or differing operating 
system. Prior to beginning this procedure, it’s advised that 
you locate the hostname (or machine name) for the Oracle 
Database 11g machine and the global database name and 
SYS account password assigned during the installation of 
Oracle Database 11g. Your database administrator should be 
able to provide this information. 
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Phase 1 of 4 

   

     

SERVER CONFIGURATION 

Create a Tablespace 
1. On the database server machine, launch Database Control for the 

database to be used by WinSPC. The default path for this is Start 
> All Programs > Oracle – OraDB11g_home1 > Database 
Control - orcl. 

2. On the Oracle Enterprise Manager 11g login page that is 
displayed: 

a. At User Name, enter SYS. 

b. At Password, enter the password for the SYS user name. 

c. At Connect As, select SYSDBA. 

d. Click Login. 
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3. On the Oracle Enterprise Manager 11g page that appears, click 
Server. 

 
4. On the Server page, under Storage, click Tablespaces. 
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5. On the Tablespaces page, click Create. 

 
6. On the Create Tablespace page, at Name, enter a name for the 

tablespace to be used by WinSPC and then, in the bottom right 
corner, click Add. 
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7. On the Add Datafile page: 

a. At File Name, enter a name for the datafile to be used by 
WinSPC. 

b. At File Size, enter 5 MB. 

c. At Storage, check the Automatically extend datafile when 
full (AUTOEXTEND) check box and specify an Increment 
amount of 5 MB. 

d. Click Continue. 
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8. On the Create Tablespace page, note the Information message 
that is displayed and click OK. 

 
9. On the Tablespaces page, note the Confirmation message that 

appears and, directly above it, click Database Instance. 
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Create a Server Login 
1. Back on the Server page, under Security, click Users. 

 
2. On the Users page, click Create. 
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3. On the Create User page: 

a. At Name, create and enter a name for the login.  (The 
recommended user name is JOHNDOE.) 

b. At Enter Password, create and enter a sufficiently strong 
password for the login. 

c. At Confirm Password, reenter the password. 

NOTE: The name and password entered here will be used by 
Oracle Database 11g to authentic WinSPC client 
machines and allow authenticated machines access to the 
WinSPC tablespace. This name and password 
combination is not directly used by WinSPC users.  
WinSPC users will, later, be assigned individual user IDs 
and passwords. They will use these individual user IDs 
and passwords to log into the WinSPC application on 
WinSPC client machines. 

d. At Default Tablespace, enter the tablespace name specified in 
step 6 of this chapter’s Create a Tablespace section. 

e. At Temporary Tablespace, enter TEMP.  
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f. Without clicking OK, click the Roles tab. 

 
4. On the Roles tab, click Edit List. 
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5. On the Modify Roles page, from the Available Roles list, select 
RESOURCE and click Move. 

 
This moves RESOURCE to the Selected Roles list. 

6. Click OK. 

7. Back on the Create User page, click System Privileges. 

 
8. On the System Privileges tab, click Edit List. 
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9. On the Modify System Privileges page, from the Available 
System Privileges list, select CREATE ANY INDEX and click 
Move. 

 
This moves CREATE ANY INDEX to the Selected System 
Privileges list. 

10. Click OK. 

11. Back on the Create User page, click OK again. 
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12. On the Users page, note the Confirmation message that appears 
and, directly above it, click Database Instance. 

 

Set the Number of Open Cursors 
1. Calculate the required number of open cursors using this formula: 

open_cursors = number of WinSPC licenses * 50 
2. On the Server page again, under Database Configuration, click 

Initialization Parameters.  
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This causes the Initialization Parameters page to appear. 

 
3. On this page, scroll down until, in the Name column, you see 

open_cursors and, in this row’s Value column, enter the number 
you calculated in step 1 of this section. 
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4. Scroll back up to the top of the page and click Apply, noting the 
Update Message that appears as a result. 

 
5. Click Logout in the top right corner of the Oracle Enterprise 

Manager 11g page. 

6. Close your browser. 

Add the Local Net Service Name 
1. On the first client machine, launch Net Configuration Assistant, 

the default path for which is Start > All Programs > Oracle – 
OraClient11g_home1 > Configuration and Migration Tools > 
Net Configuration Assistant. 
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2. In the Oracle Net Configuration Assistant prompt, on the 
Welcome prompt, select Local Net Service Name configuration 
and click Next. 
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3. On the Net Service Name Configuration prompt, accept the Add 
default and click Next. 

 



Chapter 3: Oracle 11g 

  Installation and Configuration Guide 105 

4. On the Net Service Name Configuration, Service Name prompt, 
at Service Name, enter the fully qualified service name for the 
Oracle database and click Next. (The fully qualified service name 
consists of two names separated by a period: the service name 
assigned during the setup of Oracle 11g Database, which by 
default is the same as the global database name; and the name 
assigned to the domain of which the database server is a member.) 
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5. On the Net Service Name Configuration, Select Protocols 
prompt, select TCP and click Next.  
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6. On the Net Service Name Configuration, TCP/IP Protocol 
prompt, at Host Name, enter the name of the database server 
machine and click Next. 
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7. On the Net Service Name Configuration, Test prompt, select 
Yes, perform a test and click Next.  
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8. On the Net Service Name Configuration, Connecting prompt, 
which indicates the test did not succeed, click the Change Login 
button. 
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9. In the Change Login prompt, replace the default username and 
password with the username and password you created in step 3 of 
this chapter’s Create a Server Login section and click OK. 
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10. On the Net Service Name Configuration, Connecting prompt, 
when the test is indicated as having succeeded, click Next. 
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11. On the Net Service Name Configuration, Net Service Name 
prompt, at Net Service Name, rename the default net service name 
and click Next. (The suggested name is WinSPC.) 
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12. On the Net Service Name Configuration, Another Net Service 
Name prompt, accept the No default and click Next. 
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13. On the Net Service Name Configuration Done prompt, click 
Next. 
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14. On the Welcome prompt again, click Finish. 

 

 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

   

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 
This section concerns the installation and configuration of WinSPC on 
the first WinSPC client.  (See the third assumption at the beginning of 
this chapter for a definition of the first WinSPC client.) 

If your implementation employs Microsoft Terminal Services, see the 
discussion on page 1 of this guide for direction on whether to make 
your first client the Microsoft Terminal Services server or another 
computer.   

1. Create a folder on a network file server accessible by all client 
stations that will run WinSPC.  This folder’s primary purpose is to 
facilitate the installation and configuration of WinSPC on all 
clients other than the first client.  (The recommended name for this 
folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators at least the 
minimum required permissions to it. For file servers running 
Windows Server 2003, the minimum Share permissions are 
Change and the minimum Security permissions are Modify.  For 
file servers running Windows Server 2008, the minimum Share 
permissions are Contributor and the minimum Security 
permissions are Modify. (For a procedure on granting Share or 
Security permissions, see Appendix C: Granting Share and 
Security Permissions.) 
NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these minimum permissions 
to the local administrator who will install and configure 
WinSPC on the first WinSPC client machine. 
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3. Log into Windows on the first WinSPC client machine as a domain 
administrator who also has local administrator privileges. 

NOTE: If the first WinSPC client machine is part of a workgroup 
instead of a domain, log in as a local administrator. 

4. Disable User Account Control (UAC) if the operating system on 
the first client machine has this security feature enabled. Refer to 
Appendix G for instructions on doing this. You will be given the 
option of enabling UAC in step 20 of Chapter 4: First Client 
Configuration (Final Steps). 

5. If you downloaded Install.exe from 
www.winspc.com/support/download-winspc: 

a. Transfer this file to the first WinSPC client if it was 
downloaded to a different computer. 

b. Double-click the file. 

c. If an Open File – Security Warning prompt appears, click 
Run. 

d. Go to step 7.  

http://www.winspc.com/support/download-winspc
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6. If you have the WinSPC CD (whether as a result of receiving it 
from DataNet Quality Systems or burning it from the WinSPC.iso 
file at www.winspc.com/support/download-winspc) and you did 
not complete the preceding step: 

a. Insert and run the CD. 

b. On the WinSPC Version 8.0 setup prompt that appears, click 
Install or Upgrade. 

 
c. Go to step 7. 

http://www.winspc.com/support/download-winspc
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7. Complete the WinSPC Installation Wizard. 

NOTE: The prompts of this wizard are intended to be self-
explanatory. Consequently, they are not detailed here. If 
you have a question about a prompt or want to be directed 
step-by-step through the wizard, see Appendix A: The 
WinSPC Installation Wizard. 

8. If you installed WinSPC from a CD, exit the WinSPC Version 8.0 
setup prompt by clicking Close in the upper right corner and 
remove the WinSPC CD from the CD-ROM drive. 

9. Click Start > All Programs > WinSPC > WinSPC.  This 
launches the WinSPC Configuration Wizard. 

10. On the Language prompt, from the Select language list, choose a 
language and click Next.  
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NOTE: The language selected here is the language in which the 
remainder of the WinSPC Configuration Wizard will run. 
It also becomes the system-wide default language for 
WinSPC. (This default language can be changed at any 
time following the completion of the WinSPC 
Configuration Wizard. Once the configuration of the first 
WinSPC client is complete, you can see the WinSPC 
Help for more information on default languages.) 

11. On the Database Server Type prompt, select Oracle Database 
11g and click Next. 
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12. On the Oracle Server Settings prompt: 

a. At Path of TNSNAMES.ORA, accept the default location. 

b. In the Database Alias text box, enter the Net Service Name 
you chose in step 11 of this chapter’s Add the Local Net 
Service Name section. 

c. Click Next. 
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13. On the Database Server Log In prompt, enter the tablespace login 
User Name and Password created in step 3 of this chapter’s 
Create a Server Login section and click Next. 
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14. On the Database Communications Test prompt, click Next. 

 
In the event the test fails: 

 If the error message displayed reads ORA-12154: TNS:could 
not resolve the connect identifier specified, click the Back 
button three times and reenter the database alias, ensuring you 
have the correct name and that it is spelled correctly.  Once 
you’ve reentered this information, advance through the 
WinSPC Configuration Wizard again by clicking Next, 
verifying the information on each prompt as you do. 
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 If the error message reads ORA-01017: invalid 
username/password; logon denied, click the Back button 
twice and reenter the server user name and password, ensuring 
you have the correct user name and password and that these are 
spelled correctly.  Also, since passwords are case sensitive, 
ensure the appropriate capitalization is used for the password.  
Once you’ve reentered this information, advance through the 
WinSPC Configuration Wizard again by clicking Next, 
verifying the information on each prompt as you do. 

15. On the Database Creation prompt, click Next.  This creates the 
WinSPC schema within the WinSPC database. 
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16. Allow the prompt’s progress bar to complete. 
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17. If you selected a language other than English in step 10 of this 
section, an Add Language prompt appears once the WinSPC 
schema is created.  In this case: 

a. Insert the language disk for the selected language into your 
floppy drive and click the OK button. (Language disks are 
included in your WinSPC materials. If you didn’t order a 
language disk and, consequently, did not receive one, click the 
Cancel button and complete the WinSPC Configuration 
Wizard without adding the language. Later, you can order the 
language disk and, once the disk arrives, add the language 
using the Add Language option on the Administrator 
window’s Tools menu in WinSPC. Until the language is added, 
you’ll be restricted to running WinSPC in English. The 
remainder of the WinSPC Configuration Wizard continues to 
run in the selected language whether or not a language is added 
from a language disk.) 

b. In the message asking if you want to proceed with the addition 
of the detected language, click OK. 

c. If a message indicating the detected language has already been 
installed appears, click OK. 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 
System Settings, Station Setup, or User Setup message 
appears, click OK. 

f. If the Add Language prompt reappears, click Cancel. 
g. Remove the language disk from the floppy drive. 
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THIS COMPLETES PHASE 2 OF 4. 

GO TO CHAPTER 4: FIRST CLIENT 
CONFIGURATION (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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Phase 3 of 4 

   

CHAPTER 4: FIRST CLIENT CONFIGURATION 
(FINAL STEPS) 
This chapter consists of the final steps to configure the first WinSPC 
client. With a few exceptions, these steps are common to all database 
servers. They begin midway through the WinSPC Configuration 
Wizard, just after the creation of the WinSPC schema.   

1. On the Remote Configuration Image Directory prompt: 

a. Click the Browse button. 

b. In the Directory Selection prompt that opens, navigate to and 
select the shared folder created for WinSPC, then click OK.  
This closes the Directory Selection prompt and populates the 
Directory text box of the Remote Configuration Image 
Directory prompt with the network path to the shared folder. 

NOTE: The shared folder referred to here is the one created in 
step 1 of the First Client Install and Configuration 
(Initial Steps) section you completed prior to coming 
to this chapter. 
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c. Click Next. 
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2. On the Remote Configuration Image Copy prompt, click Next.  
This copies the necessary files to the shared folder. 
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3. Allow the prompt’s progress bar to complete. 
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4. On the Custom Web Reporter Setup prompt, if you want to 
install Custom Web Reporter on the first client or you think you 
may, at some point, want to install and run it on an additional 
client, click Next. Otherwise, click Skip and advance to step 8 of 
this procedure. 

 
Custom Web Reporter is an advanced analytics and web reporting 
package that can be used with WinSPC. A free 60-day license for 
it comes with the purchase of WinSPC. For information on 
purchasing permanent licenses, contact DataNet Quality Systems 
at 1-866-4WINSPC. 
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5. On the Statit(r) Licensing Information prompt, read the license 
agreement and, if you agree, click I Agree. 
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6. On this Custom Web Reporter Setup prompt, click Next.  This 
installs Custom Web Reporter on the first client and copies the 
installation files for Custom Web Reporter to the shared folder. 
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7. Allow the prompt’s progress bar to complete. 
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8. On the System Administrator Password prompt, create and enter 
a sufficiently strong, case-sensitive password for the WinSPC 
Admin user in both the Password and Confirm Password text 
boxes. Then, click Next. 

 
NOTE: This Admin user is the only user with complete WinSPC 

permissions. 
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9. On the Finished prompt that appears, click Finish.  This causes 
the WinSPC Configuration Wizard to close. 
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It also causes the WinSPC Access Center to open. 

 
10. In the Access Center, click the Exit button. 

11. If your first client is the Microsoft Terminal Services server: 

a. Navigate to and double-click winspc.ini. The default location 
for this file is on a 64-bit machine is C:\Program Files (x86) > 
DQS > WinSPC > winspc.ini. The default location on a 32-bit 
machine is C:\Program Files > DQS > WinSPC > 
winspc.ini. 

b. Insert a blank line directly below this file’s [System] heading. 

 



Chapter 4: First Client Configuration (Final Steps) 

140 Installation and Configuration Guide 

c. On that line, enter TerminalServices=1. This informs WinSPC 
at startup that the environment is a Microsoft Terminal 
Services environment. 

 
d. Indicate whether WinSPC is to name stations based on the 

connecting station or the connecting user. This is done by 
specifying either station mode or user mode as the mode in 
which WinSPC is to run. In station mode, WinSPC uses the ID 
of the station RDPing into the Microsoft Terminal Services 
server as the station name. In user mode, WinSPC uses the ID 
of the user (i.e. the login ID with which a user logs into 
Windows on the Microsoft Terminal Services server via a RDP 
session) as the station name. For example, say Bob logs into a 
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station named Finishing and then, via RDP, logs into the 
Microsoft Terminal Services server as Sally. With station mode 
enabled, WinSPC will use Finishing as the station name. With 
user mode enabled, WinSPC will use Sally as the station name. 
Station mode is the default mode in which WinSPC runs and, 
consequently, nothing needs to be done to enable it. To enable 
user mode, directly beneath the TerminalServices=1 line 
entered in the preceding step, enter a UserMode=1 line. 

NOTE: To disable user mode in the future and have WinSPC 
run in station mode, delete the UserMode=1 line or 
change it to UserMode=0. 

e. If you enabled user mode in the preceding step, configure 
Microsoft Terminal Services to disallow simultaneous sessions 
from a user. To do this: 

i. On the Microsoft Terminal Services server, launch 
Terminal Services Configuration, the default path for 
which in Windows Server 2003 is Start > All Programs > 
Administrative Tools > Terminal Services 
Configuration. 

ii. In the left pane of the Terminal Services Configuration 
prompt, single-click the Server Settings folder. 

iii. In the right pane, right-click Restrict each user to one 
session and, from the shortcut menu that appears, click 
Yes. 

iv. Close Terminal Services Configuration. 

f. Save and close winspc.ini. 
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NOTE: The remaining steps of this procedure concern granting 
permissions for users of WinSPC on the first client. The 
permissions granted by these steps are the minimum 
permissions required to run WinSPC. These steps assume 
your WinSPC implementation employs network domains. If 
your implementation employs workgroups, instead of 
completing these steps, complete Appendix B: WinSPC 
Security for Workgroups.  

12. If you are logged into Windows on the first WinSPC client 
machine as anything other than a domain administrator, log out 
and log back in as a domain administrator.  (This is necessary 
because you will be creating a user group for WinSPC users on the 
domain controller.) 

13. Navigate to the shared folder created for WinSPC and, within this 
folder’s Utility folder, double-click WinSPCSecurity. 

 
14. In the WinSPC Security utility that launches, toward the bottom 

of the Groups tab, at Group Name, enter a name for a user group 
that will consist of WinSPC users. (The recommended name for 
this user group is WinSPC Users.) 
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15. Click the Create New Group button.   

 
This causes the user group to be added to the list of groups above 
and creates the user group on the domain controller. 

16. Check the check box for the new user group. 
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17. Click the Apply Updates button. 

 
This causes an Applying Permissions progress bar to appear. 

 
18. When the Applying Permissions progress bar closes, close the 

Security Utility by clicking the X in the upper right corner. 

19. Close the window showing the contents of the Utility folder. 

20. If the first client’s operating system has UAC and you wish to 
enable it, do so. Please note that there are a limited number of 
functions which WinSPC is unable to perform with UAC enabled. 
For more information, see Appendix G. 

21. Grant the user group for WinSPC users at least the minimum 
required permissions to the shared folder. For file servers running 
Windows Server 2003, the minimum Share permissions are 
Change and the minimum Security permissions are Modify. For 
file servers running Windows Server 2008, the minimum Share 
permissions are Contributor and the minimum Security 
permissions are Modify. For a procedure on granting permissions, 
see Appendix C: Granting Share and Security Permissions. 

22. If you intend to implement the WinSPC application server, as 
detailed in Chapter 6: Implementing The WinSPC Application 
Server, also grant the Authenticated Users user group the 
minimum required permissions to the shared folder. These 
permissions include the Read & Execute level of Security 
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permissions. For file servers running Windows Server 2003, these 
permissions also include the Read level of Share permissions. 

23. On your domain controller, add all local administrators who will 
install and configure WinSPC on additional clients and all domain 
users who, on any client, will be running WinSPC to the newly 
created user group. For a procedure on adding users to a user 
group, see Appendix D: Adding Users to a User Group.  

 

THIS COMPLETES PHASE 3 OF 4. 

GO TO CHAPTER 5: ADDITIONAL CLIENT 
INSTALLS AND CONFIGURATIONS AND 

COMPLETE PHASE 4. 

IF YOU DON’T NEED TO INSTALL AND 
CONFIGURE WINSPC ON ADDITIONAL CLIENTS, 
THIS CONCLUDES THE ENTIRETY OF THE SETUP 

REQUIRED TO BEGIN USING WINSPC. FOR 
INSTRUCTIONS ON LAUNCHING AND LOGGING 
INTO WINSPC, SEE APPENDIX E: LAUNCHING 

AND LOGGING INTO WINSPC. 
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Phase 4 of 4 

  

     

CHAPTER 5: ADDITIONAL CLIENT INSTALLS AND 
CONFIGURATIONS 

If your WinSPC implementation utilizes the conventional client/server 
architecture exclusively, meaning it does not employ Microsoft 
Terminal Services at all, complete the procedure in this chapter on 
each additional client station that is to run WinSPC. 

If your implementation utilizes Microsoft Terminal Services 
exclusively, meaning all client stations other than the Microsoft 
Terminal Services server connect to the WinSPC database through the 
Microsoft Terminal Services server, it is not necessary to complete the 
procedure in this chapter. 

If your implementation employs a mix of the conventional 
client/server architecture and a Microsoft Terminal Services 
architecture, complete this chapter for any client station that will be 
connecting to the WinSPC database directly rather than through the 
Microsoft Terminal Services server. This includes completing the 
procedure on the Microsoft Terminal Services server itself if WinSPC 
was not installed on this server as part of the first client configuration. 

1. Log into Windows on the additional client machine as a local 
administrator. 

2. Disable User Account Control (UAC) if the operating system on 
the additional client machine has this security feature enabled. 
Refer to Appendix G for instructions on doing this. You will be 
given the option of enabling UAC in step 13 of this chapter. 

3. Using Windows Explorer, navigate to the shared folder created for 
WinSPC and double-click WinSPCInstall.exe. 
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4. Complete the WinSPC Installation Wizard. For detailed 
information on this prompt, see Appendix A: The WinSPC 
Installation Wizard. 

5. Launch and exit WinSPC once while logged into Windows as a 
local administrator. To do this: 

a. Click WinSPC. The default path for this is Start > All 
Programs > WinSPC.   

b. In the WinSPC Access Center that appears, click the Exit 
button. 
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6. If you don’t want to install Custom Web Reporter on the additional 
client, go to step 7. If you want to install Custom Web Reporter:  

a. Navigate to the shared folder for WinSPC. 

b. In the shared folder’s STATIT subfolder, double-click 
CustomQC541OEM.exe. When the Installing progress bar 
that appears closes, the Custom Web Reporter installation is 
complete. 

 
NOTE: For the STATIT subfolder to exist in the shared folder, 

Custom Web Reporter must have been installed during 
the first client configuration. If this was not the case and 
you want to install Custom Web Reporter on the 
additional client, contact DataNet Quality System’s 
Product Support Help Desk at (248)-447-0140. 

7. If the additional client is your Microsoft Terminal Services server: 

a. Navigate to and double-click winspc.ini. The default location 
for this file is on a 64-bit machine is C:\Program Files (x86) > 
DQS > WinSPC > winspc.ini. The default location on a 32-bit 
machine is C:\Program Files > DQS > WinSPC > 
winspc.ini. 

b. Insert a blank line directly below this file’s [System] heading. 
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c. On that line, enter TerminalServices=1. This informs WinSPC 
at startup that the environment is a Terminal Services 
environment. 

 
d. Indicate whether WinSPC is to name stations based on the 

connecting station or the connecting user. This is done by 
specifying either station mode or user mode as the mode in 
which WinSPC is to run. In station mode, WinSPC uses the ID 
of the station RDPing into the Microsoft Terminal Services 
server as the station name. In user mode, WinSPC uses the ID 
of the user (i.e. the login ID with which a user logs into 
Windows on the Microsoft Terminal Services server via a RDP 
session) as the station name. For example, say Bob logs into a 
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station named Finishing and then, via RDP, logs into the 
Microsoft Terminal Services server as Sally. With station mode 
enabled, WinSPC will use Finishing as the station name. With 
user mode enabled, WinSPC will use Sally as the station name. 
Station mode is the default mode in which WinSPC runs and, 
consequently, nothing needs to be done to enable it. To enable 
user mode, directly beneath the TerminalServices=1 line 
entered in the preceding step, enter a UserMode=1 line. 

NOTE: To disable user mode in the future and have WinSPC 
run in station mode, delete the UserMode=1 line or 
change this line to UserMode=0. 

e. If you enabled user mode in the preceding step, configure 
Microsoft Terminal Services to disallow simultaneous sessions 
from a user. To do this: 

i. On the Microsoft Terminal Services server, launch 
Terminal Services Configuration, the default path for 
which in Windows Server 2003 is Start > All Programs > 
Administrative Tools > Terminal Services 
Configuration. 

ii. In the left pane of the Terminal Services Configuration 
prompt, single-click the Server Settings folder. 

iii. In the right pane, right-click Restrict each user to one 
session and, from the shortcut menu that appears, click 
Yes. 

iv. Close Terminal Services Configuration. 

f. Save and close winspc.ini. 
NOTE: The remaining steps of this procedure concern granting 

permissions for WinSPC users on the additional client 
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machine. The permissions granted are the minimum 
permissions required to run WinSPC. These steps assume 
your WinSPC implementation employs network domains. If 
your implementation employs workgroups, instead of 
completing these steps, complete Appendix B: WinSPC 
Security for Workgroups.   

(These steps and Appendix B can be disregarded if every 
user of the WinSPC client has local administrator privileges 
on the client machine. In such a case, close the WinSPC 
shared folder and see Appendix E: Launching and Logging 
Into WinSPC to begin using WinSPC.) 

8. Within the WinSPC shared folder, double-click Utility > 
WinSPCSecurity. 
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9. In the message indicating the application (i.e. security utility) may 
not run properly if you are not logged into Windows as an 
administrator, click Yes.  (The administrator referred to in this 
message is a domain administrator.  Being logged in as a local 
administrator, however, is sufficient for the remainder of this 
procedure.) 

 
10. In the WinSPC Security utility, on the Groups tab, check the 

check box that corresponds to the name of the user group created 
for WinSPC users. This name was entered in step 14 of Chapter 
4: First Client Configuration (Final Steps). 
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11. Click the Apply Updates button. 

 
This causes an Applying Permissions progress bar to appear. 

 
12. When the Applying Permissions progress bar closes, close the 

Security Utility by clicking the X in its upper right corner. 

13. If the additional client’s operating system has UAC and you wish 
to enable it, do so. Please note that there are a limited number of 
functions which WinSPC is unable to perform with UAC enabled. 
For more information, see Appendix G. 

14. Close the window showing the contents of the Utility folder. 

15. If the additional client station will be used by any users who were 
not added to the user group for WinSPC users created during the 
first client configuration process, go to the domain controller and 
add them.  (For a procedure on adding users to a user group, see 
Appendix D: Adding Users to a User Group.) 
 
 
 
 
 
 
 
 
 



Chapter 5: Additional Client Installs and Configurations 

158 Installation and Configuration Guide 

 

THIS COMPLETES PHASE 4 OF 4. 

NO FURTHER SETUP IS REQUIRED TO BEGIN 
USING WINSPC.  FOR INSTRUCTIONS ON 

LAUNCHING AND LOGGING INTO WINSPC, SEE 
APPENDIX E: LAUNCHING AND LOGGING INTO 

WINSPC. 
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CHAPTER 6: THE WINSPC APPLICATION SERVER 
(OPTIONAL) 

 

The WinSPC application server is new with WinSPC Version 8.3. It is 
a service to dramatically speed up the rate at which WinSPC’s 
Variable Analyzer, report templates, and data sets process data. The 
more subgroups in a WinSPC database, the greater the performance 
improvement will be. 

Implementation of the WinSPC application server, occasionally 
referred to as the WinSPC Server, is optional. Electing not to 
implement it results in no loss of WinSPC functionality and means 
only that the potential performance increase will not be experienced. 

Each installation of the application server services one WinSPC 
database. Companies that manage multiple WinSPC databases 
simultaneously will need to install a separate application server for 
each database. 

Implementation of the application server involves installing the 
WinSPC application server and configuring WinSPC to use the 
WinSPC application server. 

PART A: INSTALLING THE WINSPC APPLICATION SERVER 
NOTE: If, at any point in this procedure, you are presented with a 

User Account Control message, click the message’s Allow 
option. 

1. Identify a suitable server machine on which the WinSPC 
application server will be installed. A suitable server machine is 
one that: 

 Resides on a private network. 
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 Is not hosting the WinSPC database. 

 Does not already have an installation of the WinSPC 
application server. 

 Has 4GB RAM (or more). 

 Has disk space equaling at least 10% of the size of the WinSPC 
database with which the application server will be used. 

 Is running Windows Server 2008 or Windows Server 2003 as 
its operating system. 

 Is a member of the same domain as the WinSPC database. 

 If the database to which the application server will be attached 
is an Oracle 10g or Oracle 11g database: 

o Has a 32-bit edition of Oracle Provider for OLE DB 
installed. (The 32-bit edition is required regardless of 
whether the client station is 32-bit or 64-bit.) 

o Has had the Modify level of Security permissions for the 
Network folder granted to the Network Service user. The 
Network folder referred to here is the one created during 
the install of Oracle Provider for OLE DB. The default 
location for this folder in an Oracle 11g  implementation is 
is: C:\app\<username>\product\<Oracle Client version 
(e.g. 11.2.0)>\client_<#>\. 

2. If you have the installation CD for the version of WinSPC you are 
installing: 

a. Insert the CD into the server machine. 

b. Navigate to the Installers folder in the root of the CD. 

c. Within this folder, double-click ServerInstall.exe. 



Chapter 6: The WinSPC Application Server (Optional) 

  Installation and Configuration Guide 161 

d. Go to step 4. 

3. If you do not have the installation CD: 

a. Download ServerInstall.exe from 
www.winspc.com/support/download-winspc using the login 
credentials you received from WinSPC Support. 

b. From the server machine, navigate to and double-click this file. 

c. Go to step 4. 

4. Follow the WinSPC Server Installation Wizard prompts to 
install the application server. 

5. If desired, confirm the application server installed correctly and is 
now running. To do this: 

a. If the server machine’s operating system is Windows Server 
2008, click Start > Administrative Tools > Services and go to 
step c. 

b. If the server machine’s operating system is Windows Server 
2003, click Start > Control Panel > Administrative Tools > 
Services and go to step c. 

c. In the right pane of the Services window that appears, scroll 
down until you see WinSPC Server in the Name column. 

d. Read across to the Status column. If Started is shown, the 
application server installed correctly and is running. 

e. Close the Services window. 

6. If you downloaded ServerInstall.exe from 
www.winspc.com/support/download-winspc, delete it. 

http://www.winspc.com/support/download-winspc
http://www.winspc.com/support/download-winspc
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7. If the ports which the application server is configured by default to 
use for UDP traffic—ports 44254 and 44255—are unavailable, 
configure the application server to use two available, consecutive 
UDP ports. To do this, on the server machine: 

a. Open the WinSPC Server folder created during the installation 
of the application server. (The default location for this folder 
on a 32-bit machine is C:\Program Files\DQS. The default 
location on a 64-bit machine is C:\Program Files (x86)\DQS.) 

b. Within this folder, open the WinSPCsvr.ini file. 

c. In this file, directly under [Settings], enter ConfigPort= 
followed by the lower of the two consecutive port numbers. 
(The application server automatically determines the higher 
port number by adding one to the lower port number.) 

d. Save and close the file. 

e. Stop and restart the WinSPC Server service. 

8. If the port which the application server is configured by default to 
use for TCP traffic—port 44254—is unavailable, configure the 
application server to use an available TCP port. To do this, on the 
server machine: 

a. Open the WinSPC Server folder. (The default location for this 
folder on a 32-bit machine is C:\Program Files\DQS. The 
default location on a 64-bit machine is C:\Program Files 
(x86)\DQS.) 

b. Within this folder, open the WinSPCsvr.ini file. 

c. In this file, directly under [Settings], enter Port= followed by 
the port number.  

d. Save and close the file. 
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9. If the server machine is running antivirus software, on that 
machine:  

a. Create a folder named cache. This folder will be the repository 
for data cached from the WinSPC database. Although, you may 
create this folder in any location you wish, you will save 
yourself a step by creating it in the WinSPC Server folder. 
(The default location for the WinSPC Server folder on a 32-
bit machine is C:\Program Files\DQS\. The default location 
on a 64-bit machine is C:\Program Files (x86)\DQS\.) 

b. If, in the preceding step, you created the cache folder in a 
location other than the WinSPC Server folder, update the 
CacheRoot setting in the WinSPC Server folder’s 
WinSPCsvr.ini file to reflect that location. (Complete 
information on updating the CacheRoot setting is contained 
within the WinSPCsvr.ini file.) 

c. Configure the antivirus software to exclude the cache folder 
from the locations the antivirus software monitors and protects.  

NOTE: During operation, the WinSPC application server 
will frequently open the cache folder, write files into 
it, and then close it. Antivirus software, by design, 
will initiate a protective scan of the folder in 
response to such activity, rendering the folder 
temporarily inaccessible to the application server. 
Since no files other than those created by the 
application server will exist in the cache folder, virus 
scanning is unnecessary. 

10. With the help of your network administrator, configure the 
network so that UDP and TCP traffic can flow freely between the 
application server and all WinSPC clients.  
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11. If, at step 21 of Chapter 4: First Client Configuration (Final 
Steps), permissions to the shared folder used for WinSPC were not 
granted to the Authenticated Users user group, go to the network 
file server hosting the shared folder and, directly from that 
machine, grant this group the proper permissions to that folder. 
These permissions include the Read & Execute level of Security 
permissions. For server machines running Windows Server 2003, 
these permissions also include the Read level of Share 
permissions. (For a procedure on granting permissions, see 
Appendix C: Granting Share and Security Permissions.)  

PART B: CONFIGURING WINSPC TO USE THE WINSPC 
APPLICATION SERVER 
1. Login to WinSPC as the Admin user. 

2. In the Administrator window, from the Tools menu, select 
Systems Settings. 

3. In the System Settings window, select the Server tab. 

4. If, as part of step 7 in Part A: Installing A WinSPC Application 
Server, the default UDP ports were changed, update WinSPC to 
reflect that change. To do this: 

a. Click the Config Port button. 

b. In the UDP Configuration Port Selector window, at First 
UDP port to use, enter the same port number as that entered in 
the WinSPCsvr.ini file during step 7. 

c. Click OK. 
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5. In the Server Name column near the top of the Server tab, locate 
the name of the server machine on which the WinSPC application 
server you want to use is installed. (In most cases, there will only 
be one server name listed. Only when multiple WinSPC 
application servers have been installed will there be multiple 
names. See the introduction to this chapter for information on 
when you might wish to install multiple application servers.) With 
the name of the desired server machine located: 

a. If Available appears in the Status column beside this name, go 
to step 6. 

b. If Active appears in the Status column, that application server 
is already attached to a WinSPC database. To attach an already 
attached application server, you must first detach it from the 
database to which it is attached. Detaching an application 
server is a significant action. It denies users of the attached 
database the benefits brought about by the application server. It 
also results in the cache of the application server being cleared 
of the database’s subgroup data, a state which for a large 
database can take a considerable amount of time to restore. For 
these reasons, a WinSPC application server should only be 
detached when it is certain that doing so is appropriate. To 
detach an application server:  

i. Using the scroll bar in the middle area of the Server tab, 
scroll to the right and note the value in the Database field 
corresponding to the application server you want to 
detach. This value is the name of the database to which 
the application server is attached. 

ii. On a WinSPC client configured to use that database, log 
into WinSPC as the Admin user.  
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iii. From the Administrator window’s Tools menu, select 
System Settings. 

iv. In the System Settings window, select the Server tab. 

v. Click the Detach button. 

vi. In the Warning that appears, click Yes. 

vii. Once the Status for that application server has changed 
from Active to Available, click the System Settings 
window’s OK button. 

viii. Log out of WinSPC. 

ix. Return to the WinSPC client you were using at the 
beginning of this step (i.e. step 5). 

x. Confirm that the Status for the application server is now 
Available. 

xi. Go to step 6. 

6. Select the server machine name if it is not already selected. 

7. Click the Attach button. 

8. Once the Status changes to Active or Idle, click OK. 

9. Confirm WinSPC is correctly configured to use the application 
server. To do this: 

a. Go to the application server machine and open the application 
server log file. (The default location for this file on a 32-bit 
machine is C:\Program Files\DQS\WinSPC Server\logs. The 
default location on a 64-bit machine is C:\Program Files 
(x86)\DQS WinSPC Server\logs.) 

b. Within this log, search for the phrase Application Layer 
Started. 
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c. If this phrase is found, WinSPC is correctly configured to use 
the application server and no further steps need to be taken. 

d. If this phrase is not found, troubleshoot the configuration. To 
do this: 

i. Search for the phrase no WinSPC.ini file. If this phrase is 
not found, go to step 9.d.ii. If this phrase is found: 

(1) Close the log file. 

(2) Repeat steps 10 and 11 of Part A: Installing The 
WinSPC Application Server. 

(3) Wait one minute. 

(4) Open the log file. 

(5) Search for the phrase no WinSPC.ini file again. 

(6) If another occurrence of this phrase is found with a date 
and time that is subsequent to your one-minute wait, 
discontinue this procedure and contact WinSPC 
Support. If another occurrence of this phrase is not 
found with a date and time that is subsequent to your 
one-minute wait, search again for the phrase 
Application Layer Started.  

(7) If Application Layer Started is found, WinSPC is 
now correctly configured to use the application server 
and no further steps need to be taken. If this phrase is 
not found go to step 9.d.ii. 
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ii. Search for the phrase Provider cannot be found. If this 
phrase is not found, go to step 9.d.iii. If this phrase is 
found: 

(1) Close the log file. 

(2) Stop the WinSPC Server service. (See step 5 of Part 
A: Installing The WinSPC Application Server for 
information on accessing this service.) 

(3) Install Oracle Provider for OLE DB and grant 
permissions as detailed in the final bullet of step 1 in 
Part A: Installing The WinSPC Application 
Server. 

(4) Open the WinSPCsrv.ini file, delete all content from 
the [System] heading on, save, and close the file. 
(This file is found in the same WinSPC Server folder 
that contains the Logs folder.) 

(5) Restart the WinSPC Server service.  

(6) Open the log file. 

(7) Search again for the phrase Application Layer 
Started.  

(8) If Application Layer Started is found, WinSPC is 
now correctly configured to use the application server 
and no further steps need to be taken. If this phrase is 
not found, discontinue this procedure and contact 
WinSPC Support. 
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iii. Search for the phrase TNSNAMES.ORA file. If this 
phrase is not found or is found in an entry other than Failed 
to copy TNSNAMES.ORA file or Failed to replace 
existing TNSNAMES.ORA file, discontinue this 
procedure and contact WinSPC Support. If this phrase is 
found in either Failed to copy TNSNAMES.ORA file or 
Failed to replace existing TNSNAMES.ORA file: 

(1) Close the log file. 

(2) Grant permissions as detailed in the final bullet of 
step 1 in Part A: Installing The WinSPC 
Application Server. 

(3) Wait one minute. 

(4) Open the log file. 

(5) Search again for the phrase Application Layer 
Started.  

(6) If Application Layer Started is found, WinSPC is 
now correctly configured to use the application server 
and no further steps need to be taken. If this phrase is 
not found, discontinue this procedure and contact 
WinSPC Support. 
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NOTE: The System Settings window’s Server tab, which is a tab for 
configuring WinSPC to use a WinSPC application server, 
contains a Refresh Cache button. For most application server 
installations, this button will never have to be used. It is 
provided primarily for use by WinSPC Support 
representatives. Clicking it causes the application server to 
flush its cache entirely and reinitiate the copying of subgroup 
data from the WinSPC database, a process which can take a 
considerable amount of time with large databases.  
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APPENDIX A: THE WINSPC INSTALLATION 
WIZARD 

This appendix details the prompts encountered in the WinSPC 
Installation Wizard. 

1. On the first prompt of the WinSPC Installation Wizard, click Next. 
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2. On the License Agreement and Limited Warranty prompt, read 
the agreement and, if you accept its terms, click Yes.  
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3. On the Installation Folder prompt, accept the default installation 
folder and click Next or click Browse, select a different folder and 
click Next. (The installation folder is the folder into which 
WinSPC will be installed.) 
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4. On the Install WinSPC prompt, click Next. 
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5. Allow the installation to occur. 
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6. When the installation completes, click Finish. 

 

 

THIS COMPLETES APPENDIX A. 

RETURN TO AND COMPLETE THE FIRST CLIENT 
INSTALL AND CONFIGURATION (INITIAL 

STEPS) SECTION OF THE CHAPTER YOU WERE ON 
BEFORE COMING TO THIS APPENDIX. 
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APPENDIX B: WINSPC SECURITY FOR 
WORKGROUPS 

This appendix details the procedure for granting permissions to 
WinSPC users on a client machine that is part of a workgroup as 
opposed to a domain. The permissions granted are the minimum 
permissions required to run WinSPC. It is to be completed after step 
11 of Chapter 4: First Client Configuration (Final Steps) or after 
step 8 of Chapter 5: Additional Client Installs and Configurations. 

1. Navigate to the WinSPC shared folder created during the 
installation and configuration of the first WinSPC client. 

2. Double-click the Utility folder. 

3. Within the Utility folder, double-click the WinSPCSecurity icon. 
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4. If an error message indicating the application (i.e. security utility) 
may not run properly if you are not logged into Windows as an 
administrator appears, click Yes. (The administrator referred to in 
this message is a domain administrator. Being logged in as a local 
administrator, however, is sufficient for this procedure.)  

 
5. In the WinSPC Security utility that appears, on the Users tab, 

click the Refresh User List button. 
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6. Check the check box for each user you want to be able to run 
WinSPC on the client station. 
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7. Click the Apply Updates button.  This causes a progress bar to 
appear. 

 
8. Once permissions are applied to all selected users, exit the 

WinSPC Security utility by clicking the X in the upper right 
corner. (Later, if you wish to remove previously applied 
permissions, simply uncheck the appropriate check box and click 
the Apply Updates button.) 

9. Close the Utility folder. 

 

THIS COMPLETES APPENDIX B. 

IF YOU NEED TO INSTALL AND CONFIGURE 
ADDITIONAL CLIENTS, GO TO CHAPTER 5: 

ADDITIONAL CLIENT INSTALLS AND 
CONFIGURATIONS AND COMPLETE PHASE 4. 

IF YOU DON’T NEED TO INSTALL AND 
CONFIGURE ADDITIONAL CLIENTS, THIS 

CONCLUDES THE ENTIRETY OF THE SETUP 
REQUIRED TO BEGIN USING WINSPC. FOR 

INSTRUCTIONS ON LAUNCHING AND LOGGING 
INTO WINSPC, SEE APPENDIX E: LAUNCHING 

AND LOGGING INTO WINSPC. 
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APPENDIX C: GRANTING SHARE AND 
SECURITY PERMISSIONS 

This appendix details one method of granting a user or user group 
Share permissions to a folder and one method of granting a user or 
user group Security permissions to a file or folder.  These methods are 
applicable to both Windows Server 2003 and Windows XP Pro. 

TO GRANT SHARE PERMISSIONS TO A FOLDER 
1. Log into Windows on the computer containing the folder to which 

you want to grant Share permissions as an administrator with 
sufficient privileges to grant permissions. 

2. Using Windows Explorer, navigate to and right-click the file or 
folder to which you want to grant Share permissions and, from the 
shortcut menu, select Sharing and Security. 

3. On the Sharing tab of the <Folder Name> Properties prompt that 
is displayed, select the Share this Folder option, if it isn’t already 
selected. 

4. Click the Permissions button. 

5. In the Permissions for <Folder Name> prompt, click the Add 
button. 

6. In the Select Users, Computers, or Groups prompt that appears, 
enter the first letter of the user or user group to whom you want to 
grant Share permissions and click OK. 

7. If a Multiple Names Found prompt is displayed, locate and 
double-click the user or user group. 
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8. With the user or user group selected in the Permissions for 
<Folder Name> prompt, in the bottom pane, single-click the 
Allow check box for the desired permissions. 

9. Click OK. 

10. If you also want to grant Security permissions for the folder, click 
the Security tab in the <Folder Name> Properties prompt and, 
beginning at step 4 below, complete the To Grant Security 
Permissions to a Folder or File procedure. 

11. If you don’t want to grant Security permissions for the folder, click 
OK in the <Folder Name> Properties prompt. 

TO GRANT SECURITY PERMISSIONS TO A FOLDER OR FILE 
1. Log into Windows on the computer containing the folder or file to 

which you want to grant Security permissions as an administrator 
with sufficient privileges to grant permissions. 

2. Using Windows Explorer, navigate to and right-click the folder or 
file to which you want to grant Security permissions and, from the 
shortcut menu, select Properties. 

3. In the <Folder Name> Properties prompt that is displayed, click 
the Security tab. 

4. On the Security tab, click the Add button. 

5. In the Select Users, Computers, or Groups prompt that appears, 
enter the first letter of the user or user group to whom you want to 
grant Security permissions and click OK. 

6. If a Multiple Names Found prompt is displayed, locate and 
double-click the user or user group. 
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7. With the user or user group selected in the top pane of the Security 
tab, single-click the Allow check box for the desired permissions 
in the bottom pane. 

8. If it is a folder to which you’ve just granted Security permissions 
and you need to propagate those permissions to the folder’s child 
folders and files: 

a. On the Security tab, with the user or user group still selected, 
click the Advanced button. 

b. Check the check box labeled Replace permission entries on 
all child objects with entries shown here that apply to child 
objects. 

c. Click Apply. 
d. In the Security warning that is displayed, click Yes.  This 

initiates the propagation of permissions to child folders and 
files. 

e. When the propagation completes, click the Advanced Security 
Settings for <Folder Name> prompt’s OK button.  

9. Click OK in the <Folder Name> Properties prompt. 

 

THIS COMPLETES APPENDIX C. 

RETURN TO AND COMPLETE THE PROCEDURE 
YOU WERE WORKING ON PRIOR TO COMING TO 

THIS APPENDIX. 
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APPENDIX D: ADDING USERS TO A USER 
GROUP 

This appendix details one method of adding users to a user group on a 
domain controller. It applies to Windows Server 2003. 

1. On your domain controller, click Start > Administrative Tools > 
Active Directory Users and Computers. 

2. In the left pane of the Active Directory Users and Computers 
prompt that appears, expand the node for the domain used for your 
WinSPC implementation. 

3. Single-click Users. 

4. In the right pane: 

a. Multi-select all users who will run WinSPC and all local 
administrators who will install and configure WinSPC. 

b. Right-click any of the selected users and, from the shortcut 
menu, select Add to a group. 

5. In the Select Group prompt, enter the first letter of the user group 
to which you want to add the users and click OK. 

6. If a Multiple Names Found prompt appears, double-click the user 
group. 

7. In the message indicating that the Add to Group operation was 
successfully completed, click OK. 

8. Close the Active Directory Users and Computers prompt. 
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THIS COMPLETES APPENDIX D. 

GO TO CHAPTER 5: ADDITIONAL CLIENT 
INSTALLS AND CONFIGURATIONS AND 

COMPLETE PHASE 4. 

IF YOU DON’T NEED TO INSTALL AND 
CONFIGURE ADDITIONAL CLIENTS, THIS 

CONCLUDES THE ENTIRETY OF THE SETUP 
REQUIRED TO BEGIN USING WINSPC.  FOR 

INSTRUCTIONS ON LAUNCHING AND LOGGING 
INTO WINSPC, SEE APPENDIX E: LAUNCHING 

AND LOGGING INTO WINSPC. 
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APPENDIX E: LAUNCHING AND LOGGING 
INTO WINSPC 

If you are launching WinSPC in a Microsoft Terminal Services 
environment, connect to the Microsoft Terminal Services server using 
Remote Desktop before beginning this procedure. 

1. From the client machine, run WinSPC.  The default path for doing 
this is Start > All Programs > WinSPC > WinSPC.  

2. In the WinSPC Access Center that is displayed: 

a. At User Name, enter a valid user name   

NOTE: If this is the first time WinSPC is being logged into, 
the only valid user name is Admin. 

b. At Password, enter the password associated with the user 
name entered above. 

NOTE: The password for the Admin user is the password 
created in step 8 of Chapter 4: First Client 
Configuration (Final Steps). 
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c. Click Log In. 

 
d. If a message appears indicating that you have one or more 

unread messages, click OK. 

NOTE: For help on using WinSPC, see WinSPC’s context sensitive 
Help system.  This Help system can be accessed from within 
WinSPC by clicking a Help button wherever one appears, 
pressing the F1 key or selecting Contents from the Help 
menu. 

 
THIS COMPLETES APPENDIX E. 
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APPENDIX F: HARDWARE REQUIREMENTS 
AND RECOMMENDED 
PLATFORMS  

This appendix is provided to assist companies in the selection of 
hardware, operating systems and a database server for their WinSPC 
implementation.  It consists of two sections, one for each of the 
architectures that can be adopted for WinSPC. These architectures are: 

 Conventional Client/Server Architecture 

 Microsoft Terminal Services Architecture 

NOTE: The absence of an operating system or database server from 
any of the below lists means that the operating system or 
database server is not tested in DataNet Quality Systems’ lab. 
It does not mean that the operating system or database server 
is known to be incompatible with WinSPC or that DataNet 
Quality Systems will not do its best to support 
implementations using the operating system or database 
server. 
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CONVENTIONAL CLIENT/SERVER ARCHITECTURE 
Minimum Hardware Requirements 
Client Stations Database Server 
 1 GHz or faster 32-bit or 64-bit 

processor 
 1 GB RAM (if 32-bit) or 2 GB RAM 

(if 64-bit) for a typical Windows 7 
station  
 1 GB RAM for a typical Windows 

Vista Business station* 
 256 MB RAM for a typical Windows 

XP Pro* 
 200MB available local hard disk space 

(beyond operating system 
recommended space) 
 VGA monitor and video adapter 
 Keyboard 
 Mouse or other pointing device 
 CD-ROM or DVD-ROM drive (if 

installing WinSPC from the WinSPC 
CD as opposed to the web download) 

 
* By typical is meant a default operating 

system install and no other heavy 
RAM-consuming applications 
running. 

 Server Class processor – 
800MHz 
 512MB available RAM  
 10GB available local hard disk 

space (beyond operating system 
recommended space) 
 VGA monitor and video adapter 
 Keyboard 
 Mouse or other pointing device 
 CD-ROM or DVD-ROM drive 

NOTE: For a method to estimate 
database storage needs 
based on data specific to 
your company, see the 
How to Estimate 
Database Storage 
Requirements section at 
the end of this appendix. 

 

http://windows.microsoft.com/en-US/windows7/products/features/64-bit-support


 Appendix F: Hardware Requirements and Recommended Platforms 

  Installation and Configuration Guide 193 

Recommended Platforms 
Server Operating 
System 

Database Server Client Operating 
System 

Windows Server 
2008 

Microsoft SQL Server 2012 Windows 7 Pro 

Windows Server 
2008 

Microsoft SQL Server 2012 Windows Vista 
Business 

Windows Server 
2008 

Microsoft SQL Server 2012 Windows XP Pro 

Windows Server 
2008 

Microsoft SQL Server 2012 
Express 

Windows 7 Pro 

Windows Server 
2008 

Microsoft SQL Server 2012 
Express 

Windows Vista 
Business 

Windows Server 
2008 

Microsoft SQL Server 2012 
Express 

Windows XP Pro 

Windows Server 
2008 

Microsoft SQL Server 2008 Windows 7 Pro 

Windows Server 
2008 

Microsoft SQL Server 2008 Windows Vista 
Business 

Windows Server 
2008 

Microsoft SQL Server 2008 Windows XP Pro 

Windows Server 
2008 

Microsoft SQL Server 2008 
Express 

Windows 7 Pro 

Windows Server 
2008 

Microsoft SQL Server 2008 
Express 

Windows Vista 
Business 

Windows Server 
2008 

Microsoft SQL Server 2008 
Express 

Windows XP Pro 

Windows Server 
2008 

Microsoft SQL Server 2005 Windows 7 Pro 

Windows Server 
2008 

Microsoft SQL Server 2005 Windows Vista 
Business 

Windows Server 
2008 

Microsoft SQL Server 2005 Windows XP Pro 
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Windows Server 
2008 

Microsoft SQL Server 2005 
Express 

Windows 7 Pro 

Windows Server 
2008 

Microsoft SQL Server 2005 
Express 

Windows Vista 
Business 

Windows Server 
2008 

Microsoft SQL Server 2005 
Express 

Windows XP Pro 

Windows Server 
2008 

Oracle Database 11g Windows 7 Pro 

Windows Server 
2008 

Oracle Database 11g Windows Vista 
Business 

Windows Server 
2008 

Oracle Database 11g Windows XP Pro 

Windows Server 
2008 

Oracle Database 10g Windows 7 Pro 

Windows Server 
2008 

Oracle Database 10g Windows Vista 
Business 

Windows Server 
2008 

Oracle Database 10g Windows XP Pro 

Windows Server 
2003 

Microsoft SQL Server 2008 Windows 7 Pro 

Windows Server 
2003 

Microsoft SQL Server 2008 Windows Vista 
Business 

Windows Server 
2003 

Microsoft SQL Server 2008 Windows XP Pro 

Windows Server 
2003 

Microsoft SQL Server 2008 
Express 

Windows 7 Pro 

Windows Server 
2003 

Microsoft SQL Server 2008 
Express 

Windows Vista 
Business 

Windows Server 
2003 

Microsoft SQL Server 2008 
Express 

Windows XP Pro 

Windows Server 
2003 

Microsoft SQL Server 2005 Windows 7 Pro 

Windows Server 
2003 

Microsoft SQL Server 2005 Windows Vista 
Business 
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Windows Server 
2003 

Microsoft SQL Server 2005 Windows XP Pro 

Windows Server 
2003 

Microsoft SQL Server 2005 
Express 

Windows 7 Pro 

Windows Server 
2003 

Microsoft SQL Server 2005 
Express 

Windows Vista 
Business 

Windows Server 
2003 

Microsoft SQL Server 2005 
Express 

Windows XP Pro 

Windows Server 
2003 

Oracle Database 11g Windows 7 Pro 

Windows Server 
2003 

Oracle Database 11g Windows Vista 
Business 

Windows Server 
2003 

Oracle Database 11g Windows XP Pro 

Windows Server 
2003 

Oracle Database 10g Windows 7 Pro 

Windows Server 
2003 

Oracle Database 10g Windows Vista 
Business 

Windows Server 
2003 

Oracle Database 10g Windows XP Pro 

 

TERMINAL SERVICES ARCHITECTURE 
Minimum Hardware Requirements 
Same minimum client station and database server requirements as for 
Conventional Client/Server Architectures.   
For the Microsoft Terminal Services Server itself, the primary limiting 
factor is RAM. Approximately 25MB of RAM are consumed by each 
Remote Desktop launch of WinSPC. If a Microsoft Terminal Services 
server has 2GB of available RAM, then, it could potentially host 80 
simultaneous user sessions. Additional sessions could be hosted by 
increasing RAM or using server clusters.   
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Beyond RAM, the minimum hardware requirements for the Microsoft 
Terminal Services server are: 

 Server Class processor – 800MHz 

 200MB available local hard disk space (beyond operating system 
recommended space) 

 VGA monitor and video adapter 

 Keyboard 

 Mouse or other pointing device 

 CD-ROM or DVD-ROM drive 

NOTE:  One matter that bears mention but doesn’t qualify as a 
minimum requirement is the Microsoft Terminal Services 
server’s number of CPU cores. It is possible that, even with 
sufficient RAM, server performance could degrade 
unacceptably once a certain volume of simultaneous sessions 
is reached. It isn’t practical to state what this volume is 
because it depends in part on how active those sessions are. 
A reasonable starting allowance would be 10 sessions for 
each CPU core. 
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Recommended Platforms 
The operating system for the Microsoft Terminal Services server must 
be Windows Server 2003 (with Service Pack 1) or newer. Other than 
this, the recommended platforms for a Microsoft Terminal Services 
architecture are the same as those listed above for a conventional 
client/server architecture.  

HOW TO ESTIMATE DATABASE STORAGE REQUIREMENTS 
This estimation procedure applies equally to conventional client/server 
and Microsoft Terminal Services architectures. 

1. Multiply the average subgroup size by 37. (E.g. 5x37=185.) 
2. Multiply the average percentage of subgroups in violation by 66. 

(E.g. 2%x66=1.32.) 
3. Multiply the average number of tag values per subgroup by 17.4. 

(E.g. 4x17.4=69.6.) 
4. Add the products from the above three steps. (E.g. 

185+1.32+69.6=255.92.) 
5. Add 141.88 to the sum from step 4. (E.g. 141.88+255.92=397.80.) 
6. Multiply the sum from step 5 by the average number of subgroups 

collected per day. (E.g. 397.80x10,000=3,978,000.) 
7. Divide the product from step 6 by 1,000,000. (E.g. 

3,978,000/1,000,000=3.978.) 

The answer you get from step 7 is the number of MB of disk space you 
can expect to be consumed per day of WinSPC operation. 

 

THIS COMPLETES APPENDIX F. 
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APPENDIX G:  CONSIDERATIONS 
REGARDING WINSPC AND 
UAC  

User Account Control (UAC) is a security feature in all client 
editions of Microsoft Windows from Vista on and all server editions 
from Windows Server 2008 on. When UAC is enabled, it precludes 
WinSPC client users from: 

 Upgrading WinSPC. 

 Exporting text files of data or specifications. 

 Installing Custom Web Reporter. 

 Collecting data from an OPC server when that server is running on 
a computer different from the WinSPC client using it to collect 
data and the WinSPC client has the Use Data Advise option 
enabled.  

(Typically, a WinSPC client is only installed on a machine with a 
server operating system if that machine is a Microsoft Terminal 
Services server.) 

To be able to perform these functions, with the exception of the final 
one, UAC must be disabled. For the final function, while disabling 
UAC certainly permits it to be performed, it is also possible that your 
network administrator, depending on your network security, may be 
able to configure DCOM settings on your client and OPC server so 
that it can be performed with UAC enabled. 

The procedure for disabling UAC in Windows 7 is:  

1. Log into the Windows 7 client station as a local administrator. 

2. From the Control Panel click User Accounts. 
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3. In the User Accounts window that appears, click User Accounts. 

4. In the Make Changes to Your User Account Control Settings 
prompt, click Change User Account Control Settings. 

5. In the User Account Control Settings window that appears, drag 
the vertical slider to the Never Notify position, which is lowest 
position possible. 

6. If a window appears asking whether you want to allow the UAC 
Settings program to make changes to your computer, click Yes. 

7. Click OK. 

8. Restart your computer. 

The procedure for disabling UAC in Vista is:  

1. Log into the Vista client station as a local administrator. 

2. From the Control Panel click User Accounts. 

3. In the User Accounts prompt that appears, click Turn User 
Account Control on or off. 

4. If a Windows needs your permission to continue message 
appears, click the Continue button. 

5. In the Turn User Account Control On or Off window, uncheck 
the Use User Account Control (UAC) to help protect your 
computer check box. 

6. Click OK. 

7. When the message indicating your computer must be restarted 
appears, click Restart Now. 

The procedure for disabling UAC in Windows Server 2008 is: 

1. Log into the Windows Server 2008 station as an administrator. 



Appendix G: Considerations Regarding WinSPC and UAC 

  Installation and Configuration Guide 201 

2. From the Control Panel click User Accounts. 

3. In the User Accounts window that appears, click User Account 
Control Settings. 

4. In the User Account Control Settings window that appears, drag 
the vertical slider to the Never Notify position, which is lowest 
position possible. 

5. If a prompt appears asking whether you want to allow the UAC 
Settings program to make changes to your computer, click Yes. 

6. Click OK. 

7. Restart your computer. 

 

THIS COMPLETES APPENDIX G. 

 

 


	INTRODUCTION
	CHAPTER 1: MICROSOFT SQL SERVER 2005/2008/2012
	Assumptions
	Server Configuration
	Establish a Server Connection
	Create a Database
	Create a Server Login
	Configure the SQL Server Browser Service and Enable a Network Protocol

	First Client Install and Configuration (Initial Steps)

	CHAPTER 2: ORACLE 10g
	Assumptions
	Server Configuration
	Create a Tablespace
	Create a Server Login
	Set the Number of Open Cursors
	Test the Local Net Service Name

	First Client Install and Configuration (Initial Steps)

	CHAPTER 3: ORACLE 11g
	Assumptions
	Server Configuration
	Create a Tablespace
	Create a Server Login
	Set the Number of Open Cursors
	Add the Local Net Service Name

	First Client Install and Configuration (Initial Steps)

	CHAPTER 4: FIRST CLIENT CONFIGURATION (FINAL STEPS)
	CHAPTER 5: ADDITIONAL CLIENT INSTALLS AND CONFIGURATIONS
	CHAPTER 6: THE WINSPC APPLICATION SERVER (OPTIONAL)
	Part A: Installing The WinSPC Application Server
	Part B: Configuring WinSPC To Use The WinSPC Application Server

	APPENDIX A: THE WINSPC INSTALLATION WIZARD
	APPENDIX B: WINSPC SECURITY FOR WORKGROUPS
	APPENDIX C: GRANTING SHARE AND SECURITY PERMISSIONS
	APPENDIX D: ADDING USERS TO A USER GROUP
	APPENDIX E: LAUNCHING AND LOGGING INTO WINSPC
	APPENDIX F: HARDWARE REQUIREMENTS AND RECOMMENDED PLATFORMS
	APPENDIX G:  CONSIDERATIONS REGARDING WINSPC AND UAC

